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1 How to get Minidump Browser

Minidump Browser is free for commercial use. Minidump Browser can be downloaded for Software

Verify's website at https://www.softwareverify.com/product/minidump-browser/.

This help manual is available in Compiled HTML Help (Windows Help files), PDF, and online.

Windows Help https://www.softwareverify.com/documentation/chm/miniDumpBrowser.chm
PDF https://www.softwareverify.com/documentation/pdfs/miniDumpBrowser.pdf
Online https://www.softwareverify.com/documentation/html/miniDumpBrowser/index.html

Whilst Minidump Browser is free for commercial use, Minidump Browser is copyrighted software and is
not in the public domain. 

You are free to use the software at your own risk. 

You are not allowed to distribute the software in any form, or to sell the software, or to host the software
on a website.

Contact

Contact Software Verify at:

Software Verify Limited
Suffolk Business Park
Eldo House
Kempson Way
Bury Saint Edmunds
IP32 7AR
United Kingdom

email sales@softwareverify.com
web https://www.softwareverify.com
blog https://www.softwareverify.com/blog
twitter http://twitter.com/softwareverify

Visit our blog to read our articles on debugging techniques and tools.
Follow us on twitter to keep track of the latest software tools and updates.
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2 What does Minidump Browser do?

Minidump Browser allows you to view kernel dumps and minidumps on your machine, or your network.

32 bit and 64 bit

32 bit and 64 bit kernel dumps are supported. 

32 bit and 64 bit minidumps are supported. 
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3 Menu

The main menu contains three menus, File, Software Updates and Help.

3.1 File

The File menu controls the scanning and display of minidumps.

File menu  Load minidump...  loads a kernel dump or a minidump and displays it.

If the kernel dump or minidump is the wrong bit depth (32 bit when running 64 bit, or vice versa) then the
other version of Minidump browser is started to display the minidump.

If any errors occur when trying to load the minidump, the load fails. This means that mindumps from
ARM, IA64 and other architectures can't be displayed.

File menu  Load minidump ignoring failures...  loads a minidump and displays it.

If the minidump is the wrong bit depth (32 bit when running 64 bit, or vice versa) then the other version of
Minidump browser is started to display the minidump.

If any errors occur when trying to load the minidump, the load fails to load just the failing part of the
minidump and continues with other parts of the minidump. 
This means that mindumps from ARM, IA64 and other architectures can be displayed, but may have
incomplete information.

File menu  Exit  closes Minidump Browser.

3.2 Inspect

The Inspect menu allows you to view arbitrary memory, or to search for memory.

Inspect menu  Search memory...  search for a text string or a sequence of bytes. The Search
Memory Dialog is displayed.
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3.3 Software Updates

The Software Updates menu controls how often software updates are downloaded.

If you've been notified of a new software release to Minidump Browser or just want to see if there's a new
version, this feature makes it easy to update.

  Software Updates menu  Check for software updates   checks for updates and shows the
software update dialog if any exist 

An internet connection is needed to be able to make contact with our servers.

 Before updating the software, close the help manual, and end any active session by closing
target programs.

If no updates are available, you'll just see this message:

Software Update dialog

If a software update is available for Minidump Browser you'll see the software update dialog.



Menu 9

Copyright © 2020-2025 Software Verify Limited

· Download and install   downloads the update, showing progress 

Once the update has downloaded, Minidump Browser will close, run the installer, and restart.

You can stop the download at any time, if necessary.

· Don't download...  Doesn't download, but you'll be prompted for it again next time you start
Minidump Browser 

· Skip this version...  Doesn't download the update and doesn't bother you again until there's an
even newer update 

· Software update options...  edit the software update schedule 

Problems downloading or installing?

If for whatever reason, automatic download and installation fails to complete:

· Download the latest installer manually from the software verify website.  

Make some checks for possible scenarios where files may be locked by Minidump Browser as follows:

· Ensure Minidump Browser and its help manual is also closed

· Ensure any error dialogs from the previous installation are closed

You should now be ready to run the new version.

Software update schedule
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Minidump Browser can automatically check to see if a new version of Minidump Browser is available for
downloading.

  Software Updates menu  Configure software updates   shows the software update schedule
dialog

The update options are:

· never check for updates 
· check daily (the default)
· check weekly
· check monthly  

The most recent check for updates is shown at the bottom.

Software update directory

It’s important to be able to specify where software updates are downloaded to because of potential
security risks that may arise from allowing the TMP directory to be executable. For example, to
counteract security threats it's possible that account ownership permissions or antivirus software blocks
program execution directly from the TMP directory.

The TMP directory is the default location but if for whatever reason you're not comfortable with that, you
can specify your preferred download directory. This allows you to set permissions for TMP to deny
execute privileges if you wish.

  Software Updates menu  Set software update directory  shows the Software update
download directory dialog
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An invalid directory will show the path in red and will not be accepted until a valid folder is
entered.

Example reasons for invalid directories include:

· the directory doesn't exist 
· the directory doesn't have write privilege (update can't be downloaded)
· the directory doesn't have execute privilege (downloaded update can't be run)

 When modifying the download directory, you should ensure the directory will continue to be valid.
Updates may no longer occur if the download location is later invalidated.

· Reset   reverts the download location to the user's TMP directory 

The default location is c:\users\[username]\AppData\Local\Temp 

3.4 Help

The Help menu controls displaying this help document and displaying information about Minidump
Browser.

Help menu  About Minidump Browser...  displays information about Minidump Browser.

Help menu  Readme and Version History...  displays the readme and version history.
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Help menu  Help Topics...  displays this help file.

Help menu  Help PDF...  displays this help file in PDF format.

Help menu  Help on softwareverify.com...  display the Software Verify documentation web page
where you can view online documentation or download compiled HTML Help and PDF help documents.

Help menu  Blog...  display the Software Verify blog.

Help menu  Library...  display the Software Verify library - our best blog articles grouped by related
topics.

Help menu  Contact customer support...  displays the options for contacting customer support.

Click a link to contact customer support.

Help menu  How do I?...  displays the options for asking us how to do a particular task.
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4 The user interface

Enter topic text here.

4.1 Kernel dumps (Blue Screen of Death)

The Kernel Dump Browser user interface is shown below.

When a kernel dump contains an exception the exception display will be automatically selected as the
first display to show you information.

Not all information in a kernel dump is valid. Information that isn't valid has the same value as the
signature field: 0x45474150.

The display shows six pages of data about the kernel dump. 

Each page is listed on the left hand side. Selecting that entry displays the page on the right hand side.

4.1.1 Header

The Header page displays general information about the kernel dump.
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4.1.2 Bug Check

The Bug Check page displays exception information from the kernel dump.

For each BugCheck code we provide a link to the official Microsoft documentation for the BugCheck.
Clicking the link will open the default web browser.

4.1.3 Exception

The Exception page displays exception information from the kernel dump.
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4.1.4 Attributes

The Attributes page displays the kernel dump attributes.

4.1.5 Other

The Header page displays general information about the kernel dump.
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4.1.6 Pointers

The Pointers page displays the pointers in the kernel dump.

4.2 Minidumps

The Minidump Browser user interface is shown below.

When a minidump contains an exception the exception display will be automatically selected as the first
display to show you information.
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The display shows a summary page and then one page per logical group of data in the minidump. This
means that some discrete sections in the minidump have been coalesced - for example
ThreadListStream and ThreadExListStream are both represented in the Threads page. Each page is
listed on the left hand side. Selecting that entry displays the page on the right hand side. The summary
page lists each stream so that you can see which streams are present in the minidump and which are
absent. Few minidumps (if any) contain all streams.

4.2.1 Summary

The Summary page displays general information about the minidump, plus a list of all possible streams
and data about streams that are present.
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For each stream that is listed we indicate if the stream is present, the RVA (the offset from the start of
the minidump) to the stream and the size of the stream.

If you want to see the complete command line (for the cases when it's too long to display) use the Copy
button to copy the command line to the clipboard.

Command Line

To display the command line the minidump must contain Thread Info and memory data. The Thread Info
is used to locate the Thread Environment Block, which is then used to locate the Process Environment
Block, which is then used to read the command line.

4.2.2 Comments

The Comments page displays the contents of the CommentStreamA and CommentStreamW minidump
streams.

4.2.3 Exception

The Exception page displays the contents of the ExceptionStream minidump stream.

A few extra fields are displayed to provide additional information: Exception Symbol, Exception
Filename, Exception DLL.
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Copy Text

Copy Text copies the text from the grid to the clipboard.

Each column is separated with a comma. Each line is separated by "\r\n".

Copy Event Viewer

Copy Event Viewer copies the exception data to the clipboard in the same format as the Windows Event
Viewer. You can paste this data into some of our other tools (Minidump Browser, MapFile Browser, TDS
Browser).

An example of the data is shown below for an Access Violation at 0x0c18459c in devenv.exe.
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<Event>

  <System>

    <Provider Name="Windows Error Reporting">

  </System>

  <EventData>

    <Data></Data>

    <Data></Data>

    <Data>APPCRASH</Data>

    <Data></Data>

    <Data></Data>

    <Data>C:\Program Files (x86)\Microsoft Visual Studio 10.0\Common7\IDE\devenv.exe</Data>

    <Data></Data>

    <Data></Data>

    <Data></Data>

    <Data></Data>

    <Data></Data>

    <Data>0xc0000005</Data>

    <Data>0x0c18459c</Data>

    <Data></Data>

    <Data></Data>

    <Data>STATUS_ACCESS_VIOLATION</Data>

    <Data>OK</Data>

    <Data></Data>

  </EventData>

</Event>

Tools

If you have installed Minidump Browser, DWARF Browser, TDS Browser, MAP File Browser, the
appropriate button to launch this tool will be enabled. 

Launching the tool will attempt to load the appropriate PDB, DWARF, TDS, MAP data and then locate
the symbol that matches the exception crash address.

4.2.4 Handles

The Handles page displays the contents of the HandleDataStream minidump stream.
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For each handle that is present in the dump the following information is displayed:

Handle
The handle value.

Type
The handle type.

Object
The name of the object referenced by the handle. 

Attributes
The attributes of the handle. 

Granted Access
Access rights to the handle.

Handle Count
Number of references to the handle.

Pointer Count
Object specific count.

Object Info
Extra information about the object.

Reserved0

4.2.5 Handle Operation

The Handle Operation page displays the contents of the HandleOperationListStream minidump stream.
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Handle operation information relates to information collected by Application Verifier.

More information here: https://docs.microsoft.com/en-gb/windows/win32/api/minidumpapiset/ns-
minidumpapiset-minidump_handle_operation_list

4.2.6 Memory

The Memory page displays the contents of the MemoryListStream and the Memory64ListStream
minidump streams.

The information presented here is a list of memory start addresses and the size of the memory at that
address.
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Context Menu

A context menu provides a single option:

Clicking View data... opens a memory inspection dialog, allowing you to view the memory as BYTEs,
WORDs, DWORDs or QWORDs. For executable code a disassembly view is provided.

4.2.7 Memory Info

The Memory Info page displays the contents of the MemoryInfoListStream minidump stream.
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The information here allows you to inspect the memory protection status of areas of memory in the
minidump.

If you'd like to view this information in graphical form you can also use VM Validator. VM Validator views
memory data in live processes and minidumps.

4.2.8 Misc Info

The Misc Info page displays the contents of the MiscInfoStream minidump stream.

This section provides miscellaneous information about the minidump application.
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4.2.9 Modules

The Modules page displays the contents of the ModuleListStream minidump stream.

For each module in the minidump this page displays the following information, dll load address (image
base), size, checksum, timestamp, file version, product version, application attributes and module name
(with optional path).

4.2.10 Tokens

The Tokens page displays the contents of the TokenStream minidump stream.
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4.2.11 Threads

The Threads page displays the contents of the ThreadListStream and ThreadExListStream minidump
streams.

For each thread the following information is displayed: thread id, thread name, if the thread is suspended,
it's priority class, it's priority level, the thread environment block (TEB) address, the stack location and
size and the flags used to create the thread context, plus a dump of some thread context members
(processor registers etc).

4.2.12 Thread Info

The Thread Info page displays the contents of the ThreadInfoListStream minidump stream.
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For each thread the following information is displayed: thread id, thread name, dump flags, dump error
status, thread exit status, thread creation time, exit time, kernel time, user time, thread start address
and thread processor affinity.

4.2.13 Thread Names

The Thread Names page displays the contents of the ThreadNamesStream minidump stream.

For each thread the thread id and thread name is listed. We use this information to provide thread names
on appropriate other minidump displays.
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4.2.14 System Info

The System Info page displays the contents of the SystemInfoStream minidump stream.

This page provides information about the computer hardware and the operating system you are using.

4.2.15 System Memory Info

The System Memory Info page displays the contents of the SystemMemoryInfoStream minidump
stream.
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This page provides detailed information about the memory state of the system.

4.2.16 Unloaded Modules

The Unloaded Modules page displays the contents of the UnloadedModuleListStream minidump stream.

For each module in the minidump that has been unloaded this page displays the following information, dll
load address (image base), size, checksum, timestamp, module name (with optional path).

4.2.17 VM Counters

The VM Counters page displays the contents of the ProcessVmCountersStream minidump stream.
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This page provides detailed information about the virtual memory counters of the system.

4.3 Search Memory Dialog

The Search Memory dialog is shown below.
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You can search for text strings or you can search for byte sequences.

Search for a text string  type the string you wish to search for into the text box

Match case  select the check box if the string match should be case sensitive

Unicode  select the check box if the string match should be Unicode. If the check box is not selected
the string match is ANSI

Search for bytes  type the bytes you wish to search for into the text box. A byte should be specified
as a two digit hex value. Separate bytes with spaces

Search  perform the search. The progress of the search is shown on the progress bar, any matching
search results are shown in the list.

Clear  clear the search results

A context menu on the search results provides a single option:
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Clicking View data... opens a memory inspection dialog, allowing you to view the search results
memory as BYTEs, WORDs, DWORDs or QWORDs.
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